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This softwareis Copyright (©2002by The Regentsof the University of California. All RightsResered.

Permissiorto use,copy, modify, anddistribute this softwareandits documentatiorfior educationalresearctandnon-
profit purposeswithout fee, and without a written agreements herebygranted provided that the above copyright
notice,this paragraptandthe following threeparagraphappeaiin all copies.

Permissiorfor commercialuseor to incorporatehis softwareinto commercialproductsmay be obtainedby contact-
ing the TechnologyTransferOffice, 9500Gilman Drive, 411 University Center University of California,La Jolla, CA
92093-0093(858)534-5815,nvent@ucsd.edu

This software programanddocumentatiorare copyrightedby The Regentsof the University of California. The soft-
ware programanddocumentatiorare supplied“as is”, without any accompaying servicesfrom The Regents. The
Regentsdoesnot warrantthat the operationof the programwill be uninterruptedor errorfree. The end-usemunder
standghatthe programwasdevelopedfor researcipurposesndis advisednotto rely exclusively onthe programfor
ary reason.

IN NOEVENT SHALL THEUNIVERSITY OF CALIFORNIA BE LIABLE TOANY PARTY FORDIRECT, INDI-
RECT, SPECIAL,INCIDENTAL, OR CONSEQJENTIAL DAMAGES,INCLUDING LOST PROFITS,ARISING
OUT OF THE USEOFTHIS SOFTWARE AND ITSDOCUMENTATION, EVEN IF THE UNIVERSITY OF CALI-
FORNIAHAS BEENADVISED OF THE POSSIBILITY OF SUCHDAMA GE. THE UNIVERSITY OF CALIFOR-
NIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESSFORA PARTICULAR PURPOSETHE SOFTWARE
PROVIDED HEREUNDERIS ON AN “AS IS” BASIS, AND THE UNIVERSITY OF CALIFORNIA HAS NO
OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPOR, UPDATES, ENHANCEMENTS, OR MODIFICA-
TIONS.

This software was developedwith governmentsupportunder Office of Naval ResearchAward
Number:N000140110403Thegovernmenthascertainrightsin this software.

Developmenf this softwarewasalsosupportedundera grantfrom the G. UngerVetleserFoun-
dation.
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1 GeneralOverview

Analog seismicdatahave beenrecordedon numerouspen and paperdrum-typeseismographs
throughoutheworld overthe pastl00yearsor so. Digitizing scannedmagesof resultingseismo-
gramsusingtheavailableversionof digitizing software(NxScan V. 8.0) wasextremelyproblematic
becausé&ixScan waswritten for SunMicrosystenmworkstationsduringthe 1980s andusesheob-
soleteunsupportedpixrect” primitivegraphicdibrary writtenfor the1980s Sunarchitectureand
operatingsystem.Additionally, NxScan wasnot designedor the efficient digitization of day-long
seismograms$or climatologicalstudies(e.g. Bromirski et al. [1]). After considerablesffort was
spentattemptingto improve and stabilize NxScan, incompatibilitiesof pixrect with currentSun
architecturegontinuedto causerepeatectrashesmakingthe efficient digitization of month-long
time seriesimpossible. Thus, SeisDig wasdevelopedusing Matlab, which makes SeisDig essen-
tially computerandoperatingsystenmindependentThehopeis thatSeisDig canberelatively easily
maintainedasMatlab andcomputersystemsvolve.

Examplesandillustrationsin thismanualweremadefrom Galitzin seismogramf&om the Berkeley
Seismologicalaboratory(BSL) archivesthatwereelectronically‘scanned at400dpi (dots/inch)
usinganIDEAL FSS800dull lengthscannerandstoredas*tif ” files. Eachscannedseismogram
imageconsistf a seriesof quasi-parallesequentiaBO-minuteor 60-minutetraceshatgenerally
cover abouta day, with two partial tracesat the beginning and end of eachimage. One-minute
timing marksusually causesmall gapsat the end of eachminute. In additionto high amplitude
earthquak signals thearrival of high amplitudestormwavesat nearbyshorelinegBromirski and
Duennebier [2]) cause®levatednoiselevelscalled“microseisms, bothtypesof signalsresulting
in the occurrenceof adjacentraceintersectionspverlaps,andreducedine thicknesghatcompli-
catedigitization.

Storageproblemsovertime have damagedomeseismogramgparticularlyatedges)furthercom-
plicatingdigitizationof full seismogramsDegradatiorof theseismogranpaperquality (especially
for mary pre-1950seismogramsygndthe difficulty in perfectlyaligningthe 40 inch long seismo-
gramsin the scannerfeed groove, commonlyresultin eitherslightly skewed or slightly curved
traceimagestypically exaggeratedt the traceends.Thesescanningartifactsbhecomeapparentf

the horizontal:\erticalimageratio is augmentedbut aredifficult to identify in theraw tif images.
The effectsof thesescanningartifactswere minimized by fitting a third order polynomialto the
imagetracedo establisrareferencdine for eachtraceto determinghedigitizedtraceamplitudes.

Becauseof presumablyarying voltage,Galitzin seismograplidrum speedvariability resultedin

the Time ScaleFactor (TSF) varying from about450 to 480 pixels/min. Impactof the variable
TSFis minimized by using an averagepixels/mindeterminedor the entire seismogram.When
digitizing relatively shortdurationearthquak signals,estimate®f the TSFshouldbe madeeither
just prior to the eventor from anaverageof the TSFfor tracesbeforeandafterthe event.
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2 Main Features

SeisDig is a GraphicalUserInterface(GUI) basednteractve digitizing tool. Digitizing operations
aremouseselected Becausaligitizing numerousentire seismogranmimagesefficiently is critical
for studyingthe characteristicef extremestormsandtheir occurrencdor climatechangeanaly-
ses,automatedraceimagetrackingis necessaryEfficient digitizing necessitatea minimum of
userinteraction.

SeisDig — /home/stchua

File Image Edit

Insrt Citd

M Center ¥

Del Cidl Pt

Select Pts || -
Erase Tm[:ﬂ

W Cwrent ||

Shift Image|
Z00im
EE

Image Ratio
.
X Y

Auto Scroll||
Delay IT

UILINE#|<<| < 38 =] ==+
Digitize:  Line Pt 2Pt
Max Perviod: zp0 SmoothData|
SCALE FACTORS

Time (min) Amp (in.}
Length: 30 307 35,533
pizfunit: gz 400

Figurel: A portion of the seismogranfor Dec. 17, 1940viewed with SeisDig shaws the trace
variationobseredin pre-1962Galitzin seismogramsyith anexampleof fadedtracelinesat the
seismogramedgethat sometimesoccursin older seismogramsThe scannedraces(thick white
lines)shav examplesof adjacentraceintersectiongluringrelatively high amplitudenoiselevels.
Theprojecteddigitizedtraceqbluelines)successfullyrack pasttheseirregularities. Themagenta
traceis the current(active) traceunderinspection. The Edge Line (vertical greenline) is shavn
on the left, its position adjustedto consere the total elapsedime of the seismogram.The full
seismogrammageis shavn in the locatorpanelat the lower right, with the portion of theimage
shavnin themainimagepaneloutlinedby theredboxandtheactive traceidentifiedby thedashed
magentdine. Theright EdgeLine is setat the well definedtraceends. The paperseismogram
physicaltracelengthin inches(determinedisingthe Amp. SCALE FACTOR valuedisplayedj.e
theDPI) is shovn atthetop of boththe main SeisDig andthelocatorpanels.
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Timing marks,occurringat 1-minuteintenvals in most Galitzin seismogramsgausesmall gaps
in the seismogrammage, and high amplitudesignalsresultin traceintersectionsand overlaps
(Fig. 1). Thetracewidth canvary within atraceaswell asfrom traceto trace. Eachof these as

well asothergapsandthin or intermittentlines, cancauseancorrecttrace-tracking.The necessity
of settingcontrolpointsatgapsandintersectionsvassubstantiallyeliminatedwith atrace-tracking
algorithmthatfollows the centerof the traceimage(in the vertical cross-sectionandusesa com-

binationof slopeestimatedsrom boththe precedingdigitized pointsandthe traceamplituderange
to constraintheforwarddigitizing search.Tracetrackingis furtherconstrainedo recrosgshebase-
line within a userselectedime period. Incorrecthandlingof traceintersectionandotherimage

irregularities(commonlyoccurringwhenhigh amplitudesignalscauserepeatedraceintersections
or overlaps)are easily identified by visual inspectionof the projecteddigitized trace overlaying

theraw imagetrace. The GUI allows interactve modificationof the digitized trace(s)(aswell as

settingcontrol points at traceendsfor pre-processingprior to saving to an outputfile for cases
whenimagequality and/orcompleity warrantuserinteraction.

SeisDig operate®nblack-and-whitemages0-and-1pixel valuesyespectiely. Grayscaler color
imagesareautomaticallycorvertedinto black-and-white.

2.1 Installation and Matlab/SystemRequirements

A “tar” file containingthe Matlab SeisDig m-filesandsampleimagefiles canbe downloadedrom
http : //iod.ucsd.edu/SeisDig/ andshouldbe untarredin the users ~/matlab directory creat-
ing aSeisDig directorywith adatasubdirectorycontainingsampleémagefiles,andshouldbeadded
to theusers MATLABPATH. Minimum systenrequirementsMatlabV.6.0or higherwith Image
ProcessingSignalProcessingandStatisticsToolboxes,and256 Mb memory;Matlabv.6.1+with
512+Mb memoryrecommended.

2.2 Image File Formats

Acceptablenputimagefile formatsarethosethat Matlab function“imread” supports.Thesein-
cludeTIF, JPEG,GIF, BMP, PNG, HDF, PCX, XWD, ICO, CUR. Imagesof thesetypescanbe
importeddirectly without requiringcorversionor modification.

2.3 Required UserInputs

If theimagedoesnot containtiming marksor only a sectionof atraceis to bedigitized, the user
is requiredto enterthetime in minutes(1) betweerthe EdgeLines(generallybetweeridentifiable
minute marks),which is neededo determinethe Time ScaleFactor The “dots perinch” (DPI)
imagescanrate(2) determinesamplitudescaling(the defaultis 400dpi). If the DPI is unknown,
the physicallengthof the horizontaldimension(independenvariable)of the scannedmagemust
be entered. In the Export (Preview) window (seeSection3.1.3 Fig. 5), the useris requiredto
enter(3) the absoluteStart Time of the seismogranor the sectionof the imageto be digitized,
and(4) the desireddigital outputsamplingrate,i.e. 1/Delta. Whendigitizing entire seismogram
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images,the absoluteEnd Time (5) may also be neededo ensurethat the independentariable
(time) is correctly consered during traceconcatenation Additional headerinformation prior to
output, suchas stationnameand channelidentifier, are optional but canalso be enteredin the
Export window.

2.4 Pre-Processing

Much of the time requiredfor digitizing an entire seismogrammage (dependingon the degree
of userinteractionneeded)s CPUandmemoryintensve, with digitizing a 30min tracerequiring
aboutl.5min or more. For efficientdigitizing of day-longseismogranmagesit is usefulto deter
minetheprojecteddigitizedtracesor the entireseismogranprior to inspectionmodification,and
saving. After loadingtheimagefile, controlpointsmustbe selectedat bothendsof all tracesto be
digitizedwhile in Insert mode.Thesepointsshouldbe nearthetraceends but neednot be exactly
attheendof thetraceimage.For efficientcontrolpointselectioralongonesideof theseismogram,
activatingthe Line # checkbox allows automaticincrementatiorof the line numberwhenadding
successie line-endcontrol points(seeSection2.6). Controlpointscanbe setat traceendsalong
onesideof theseismograneitherwith individualmouseclicks ateachtraceend,or settinga series
of endcontrolpointsby holdingdown theleft mousebuttononthenon-imageegion (black)above
theinitial traceendof the seriesanddraggingthe cursorto the non-imageregion below the last
tracein the serieg(i.e. black-to-black).Line #'s for groupsof multiply-selectedccontrol pointsare
automaticallyincrementedrom top-to-bottom,anddecrementeavhendraggingthe cursorfrom
bottom-to-top(this makessettingcontrolpointsattraceendsmoreefficient). Groupsof incorrectly
labeledtrace-endcontrol-pointline numberscanbe selectedoy toggling the Select Points button
andholdingdown theleft mouseanddraggingthe cursor Selectedyroupsof controlpointscanbe
decrementedr incrementedisingthe —— or ++ buttons,respectiely.

/home fstchuangproject/1940/dec /b
prep-rot-90 miry filt brk 40 12 15.dat: |
prep-rot-20 mivy fit wk 40 12 16.dat:
prep-rot-90 miry filt bk 40 12 18.dat [
prep-rot-20 mivy fit wk 40 12 19.dat:

’

~| | =~
Add | Remove | Digitize Files |

Figure2: The pre-processinfjle list showving typical filenamesproducedoy prep_images.m. The
highlightedpreppedmagefile wasdigitized, with the outputdisplayedn Fig. 1.

Thedefaultintermediatgrocessindilenameshave the samebasenamastheimagefile, although
theusercanenterary filename.Projectedracedataand/orassociatedontrolpointandEdgeLine
dataaresavedin afile having a“.data” extension(unlessthe userentersa differentfilename)by
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clicking onthe " Save Data” buttonin the File menu. This filenameautomaticallyappearsn the
“PreprocessFileList”, locatedin thelowerleft cornerof Fig. 1. The*.datafilesareactually*.mat
Matlab“save” files. Thedirectorypaththatthesefiles arestoredin is shovn above the Preprocess
File List. Double-clickingon filenamesin this list, eitherimage*.tif or *.datafiles, will load
thatfile. Filesto be digitized (that containtrace end control points) can be addedor removed
from the Preprocess File List (Fig. 2) usingthe “Add” or “Remove” buttons,respectiely, with
thefiles to be processedhighlightedafter beingselectedrom thelist by mouseclick. Preprocess
files not in the currentdirectory can be addedto the list usingtheir completepathnames.The
CPUintensve operationanthenbe performedat a corvenienttime by clicking on the“Digitize
Selected” button, with computedprojectedtracesstoredin a *.datafile thathas“tr-” prepended
to the filename. “Load Data” (in the File menu)loadsthe selectedracetr*.data objectfile for
inspectionandcorrectionwith theuserpromptedo loadtheassociatedmagefile for comparison
with the projectedracesf it is notalreadyloaded.Inspectionof the projecteddigitizedtracescan
be donecorvenientlyusingthe Auto Scroll function.

2.4.1 Preparing Imagesfor Digitizing

Remaring straypixel “noise” from imagesand90° rotationsaretime consumingoperationsWhen
digitizing multiple seismogramshat requirethe sameoperationso preparethe imagefor trace
end control point selectionand digitizing, it may be more corvenientto do filtering and rota-

tion operationsusingthe prep_images.m functionthatcanberun independentlyf SeisDig (“help

prep_images” in Matlabgivesusage).This functionperformsthe sameoperationsasin thelmage

menuwithin SeisDig, creatinga new tif file (with thefilenameprependeadvith “prep-" andabbre-
viationsof all operationperformedFig. 2). Prepedif filescanbeloadedaterto setcontrolpoints
attraceends,with controlpointandimagedataautomaticallystoredin anew file having thesame
basenamasthe preppedif file but with a“.data” appendagewyith the new filenameautomatically
addedo the Preprocess File List for digitizing.

2.5 Edgelines

Edgelinesareusedto delineatehehorizontal(independenvariable time) traceextent. Edgelines
needto be setprior to Export. Edgeline locationscanbe adjustedoy positioningthe cursorover
the EdgeLine, holding down the left mousebutton, and draggingthe EdgeLine to the desired
location. Incorrectscanningcan causethe traceendsof seismogramso not be aligneddirectly
beneatreachother i.e. non-wertical, which canbe identifiedby increasinghe horizontal:\ertical
Image Ratio. To accountfor the slight slopeof thetraceendsandconsere the total elapsedime

in the seismogramthe EdgeLines may berotatedby positioningthe cursorover the upperendof

the EdgeLine, holdingdown the left mousebuttonanddraggingthe cursorto eitherside.

Whendigitizing full seismogramg;dgeLine locationsareselectedy picking a balancebetween
thequality of theimagetraceendsandthetracelengthof the paperseismograntkeepingin mind
thatthereis a slight slopeto the spiralingtracesresultingin thetracelengthbeingslightly longer
thanthe seismograpldrum circumference)lf thetracelengthis measuredadjustthe EdgeLines
until the valuein the ScaleFactorsAmp. Length dialog box matcheghe measuredength. If the
imagequality is poorat oneend(asin Fig. 1), setthe EdgeLine at the goodendanditeratively
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adjusttheotherEdgeLine to themeasuredracelengthand/oruntil the Total (elapsed)limein the
seismogran{determinedn the Export (Preview) window, Fig. 5 in Section3.1.3 is adequately
consered.

I LINE#|<<| <| 38 =] --|+4
Digitize: Line I Pt ? Pt I
Max Period: 700  Smooth Data |

Figure3: Line activationanddigitizing controls.

2.6 TraceActivation (Line Numbers)

When multiple tracesare being digitized, the current(active) line numberis displayedin the
“Line#” dialogbox (Fig. 3) belon the main SeisDig imagepanel(Fig. 1), with the currenttrace
underinspectionidentifiedwith a magentdine (otherprojecteddigitized traceshave bluelines).
The location of the active traceis also identified by a magentdine in the locator panel. Line

numbersare also displayedto the left of the mainimagepanel. Line numbersare usefulwhen
editingconnectiorsectiondetweersuccessie concatenatettaces A line is “activated’ or made
“current” (i.e. selectedor control point changesand/ordigitizing) by enteringthe desiredline

numberin the Line # dialog box and striking “Enter” on the keyboard,usingthe associatedor-

ward > andbackward < arrows for scrolling,or by clicking onthe desiredine numberto theleft

of the mainimagepanel. The << button makesthe lowestnumberedracethe active trace. For
efficiengy whensequentiallysettingpre-processingontrol pointsfor successie traceendpoints
at onesideof the seismogrammage,the line numberis automaticallyincrementedf the Line #
checkbox is activated. If left andright sideline numbersareinadwertentlymisaligned(indicated
by theyellow baselinedaving substantiatlopesbecaus¢he endpointsareincorrectlyselectedn

adjacentraces) resequencinganbe accomplishedy selectinggroupsof control pointson one
sideof the seismogranfby holding down the left mousebutton anddraggingthe cursorwhile in

Sect Points mode)andclicking on eitherbackward —— or forward ++ buttons.

2.7 Trace Digitizing and Filtering

Individual tracedigitizing is accomplishedy clicking on “Line” (redon blue, Fig. 3) to digitize
theentiretrace,or “Pt 2 Pt” to digitize the portion of the tracebetweerselectecpoints. TheLine
andPt 2 Pt buttons(red with blue backgroundpperateon the currentactive line indicatedin the
Line # dialogbox. ThePt 2 Pt functionis usedduring projectedracemodificationprior to export.
The Pt 2 Pt endpoints, BeginningandEnd, are selectedwith left mouseclicks after clicking on
the Pt 2 Pt button. To facilitatethe selectionof the End pointin Pt 2 Pt mode,right mouseclicks
shift theimageonly horizontally Notethatfloating baselinesareusedbecausef potentialtrace
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cunvature.Thebaselindocationis determinedrom alinearleastsquaredit to all controlpointsin
aline, andthetrace-trackingalogorithmoperateselative to this baseline.Consequentiyto avoid
the possibility of changingacceptablgreviously digitized portionsof a trace,the Pt 2 Pt opera-
tion shouldgenerallybe usedwhenmodifying previously digitized dataafter insertingadditional
controlpointswithin the poorly tracked segment. The maximumtime in secondsllowedbetween
recrossing®f thereferenceébaselinds givenby “Max. Period”, andis particularlyusefulfor high
amplitudedatawith multiple overlaps.

Theimageline-thicknessvariability alongthe tracecausesmalljumpsin the projecteddigitized
trace unrelatedto the frequeng contentof the underlyingsignal. Consequentlya three-point
triangularfilter is automaticallyappliedto the digitized output. If inspectionof the digitizedtrace
warrantsfurther filtering, additionaltriangularfiltering of the current(active) projecteddigitized
trace can be appliedby clicking on the “Smooth” button, with eachmouseclick successiely
applyingathree-pointriangularfilter to the currentprojecteddigitizedtrace which canbeundone
if theresultis unsatiséctory Note thatthisis a lowpassfilter thatwill causea lossof enepy at
higherfrequencies.
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3 Menus

All operationsiecessaryo digitize anentireseismogranimagecanbe performedwithin the GUI,
including imagefiltering (for “noise” reduction),imagerotationandinversion,and outputtrace
inspectionandmodification.

Therearethreemainmenusatthetop left cornerof the GUI (Fig. 1): File, Image, andEdit.

3.1 File Menu

Operationsunderthe“File” menudealwith loadingandsaving imageanddatafiles.

Load Image..
Load Data...

Save lmage...
save Data..

Export (Preview)...

Close

Figure4: OperationgerformedundertheFile menu.

3.1.1 Importing Imagesand ProcessingData

Imagesare imported (loaded)by clicking on the “File” button at the top left handcornerand
selecting“Load Image”, andthenselectingthe desiredimagefile from the directorydialog box
thatpopsup. Similarly, files containingcontrolpointsandpre-processegdrojectedraceestimates
canbe loadedby selecting“Load Data”. The filenameof the loadedimagebeingdisplayedis
showvn atthetop of the SeisDig window.

3.1.2 Saving Imagesand ProcessingData

Similar to importing images,modifiedimagesand processinglata(including control pointsand
EdgelLine locations)canbe savedfor further editing by clicking on the “Save Image” and“ Save
Data” buttons,respectiely. All userentereddata,including control points,EdgeLine locations,
andprojecteddigitizedtraceestimatesrestoredin thetr*.datafiles underSave Data. Changeso
araw image(eitherorientationor filtering) canbe storedby clicking on the Save Image button.

3.1.3 Exporting Digitized Data

Digitized dataare saved to disk by clicking on “Export (Preview)”. An Export window (Fig. 5)
popsupin whichtheusermustenterthe StartTime andthe samplingrate(1/Delta)of thedigitized
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Time (minutes)
977

978

Start |12!1 FA940 8:28 AWM | Samplesfsec: 1 # Sec Displayed: | 600 <Prav | _| Line | Hexts |
End Time |1 2/18/1340, §:36:00 AM Station BRK Event Hame: max 16 chars Save as SP.Cl
Month Julian day  Year Comp. Name: LHZ _Event Origin:||  -12345 Jave as MPlTI
352 1940 Min: -6.16 Arst Amival |  -12345 Save as Both|

hour : min : sec : ms Mean -3.16e-05 Event End:|| -12345
8 :z6 /0 : oo Max: 6.22 Total Time (sec): 6530 Cancel |

Figure5: Layoutof the Export (Preview) pop-upwindow. Thetop panelshows the concatenated
outputof thedigitizeddatafor thefull seismogranshovnin Fig. 1, containing4d8tracesof approx-
imately 30min durationeach. The portion of the digitized traceoutlined by the red locatorbox
(600s) in the upperpanelis expandedn the main panelfor detailedinspection.The yellow dots
indicatethesampledamplitudedo beexported.Notethesemi-rgularcoda-like arrivals,indicative
of microseismgeneratedby thearrival of oceanswell at nearbyshorelines.

tracedata,and ary SeismicAnalysis Code (SAC) headerinformation available. “# Sec. Dis
played” givesthelengthof thetime segmentdisplayedn the mainpanelin secondsThelocation
of the expandedracesectionshovn in the main panelcanbe selectedoy eitherclicking on the
tracein the top panel,draggingthe slide bar at the bottom of the main panel,or clicking on the
“<Prev” or “Next>" buttons(whenthe associate@¢heckboxs setto Line) to inspectconnections
betweenconsecutie concatenatetraces,with the connectionpointsindicatedby vertical green
linesin the main panel(Fig. 5). Toggling the Line checkboxin the Export window switchesto
Nmax, which allows jumpingto successie tracemaxima(usefulfor locatingspikesthataregen-
erally associateavith improperlydigitized segments).

Headelinformationfor SAC outputrequiresentryof thesamplingrate(1/Delta,samples/sandthe
StartTime of the data,which includesdateinformation. The StartTime correspondso the stan-
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dardSAC headerReferencelime”, but differsin SeisDig whereit mustbethe beginningtime of

thedatabeingdigitized. Theinverseof the samplingrate,i.e. thesamplinginterval Delta,is output
in theSAC headersThelocationsof samplesakenfor agivensamplingratearedeterminedy the

numberof pixels/s,which is obtainedfrom the measuregbixels/minfrom the seismogranimage.
The 400dpi Galitzinimageshave about7.7 pixels/s. Unlike NxScan which truncatedhe pixels/s
estimatecausingslightly shiftedspectralestimatesSeisDig usessplineinterpolationto determine
thetraceamplitudesat thelocationsspecifiedby the samplerateentered.

To checkthe conseration of total elapsedime whendigitizing full seismogramsthe End Time

needdo beentered.A pop-upwindow givesthe Digitized Total Time (determinedrom the digi-

tizing processpndthe EnteredTotal Time (determinedrom the StartandEnd Timesentered)n

secondsTypically, thesediffer by afew hundredsecondgor afull day-longseismogramTheuser
hasthe option of acceptingthe EnteredTotal Time (generallyrecommended)n which casethe
samplinginterval (i.e. the Time ScaleFactor TSF) will be adjustedaccordingly and/orslightly

shifting one or both of the EdgeLines andthenre-Exporting. Note that the TSF is an average
estimatefrom all theindividuallinesin the seismogramandthushasanassociategariance.

Digitized dataare exported by selectingeither “Save as SAC” (the commonSAC format) or
“Save as MAT” (a Matlab *.mat file that mimics the SAC2000 Matlab output). SAC2000can
bedownloadedrom http://www.lInl.gov/sac/. The Matlaboutput*.matfile includesatracevector
(SeisData), anda header‘structure” (SACdata) that containsnecessarynformationfoundin the
SAC2000Matlab headerincluding a SeisDig structcontainingdigitizing parametergSection9).
Thereareoftennumerousdatagapsin the older Galitzin seismogramsgseeFig. 1). Thus,in order
to keepthe numberof datafiles to a manageabléevel, the SAC files generatedy SeisDig differ
from standardSAC files in thatmissingdatagapsaredesignatedby “-12345”, andwith NaNsin
the Matlab*.mat outputfiles. The outputdigitizedtraceamplitudesarein millimetersandcorre-
spondto traceamplitudesof the paperseismogramThe SAC headewariable“scale”is setequal
tol.

The Begin Value andEnd Value fieldsin the SeisDig SAC headeraresetto thefirst andlastdata
pointsexported.If anearthquak eventis embeddedvithin theoutputdata,the Event Origin, First
Arrival, Event End timesmay be selectedoy mouseclicking on pointsin the main Export panel
afteractivatingtherespectire button,with middlemousebuttonclicks causingateraltranslationof
thetraceimagecenterecht the cursorlocation. The eventtimesareindicatedby verticalmagenta
linesin the main Export panel. The valuesfor the eventtimesstoredin the SAC headerarethe
numberof sampledrom the beginningof theoutputtrace.Thesepointscanbelocatedin absolute
time from the Start Time of the datafile andthe Delta. Choosingeventtimesis optional, with
thesevaluessetto “-12345” in the SAC headeiif unspecifiedEntering-12345<cr> in ary of the
Eventfieldserasesheassociatednagentdine.

3.2 ImageMenu

Thedigitizing algorithmoperategrom screeneft to right. Thus,the independenvariable(time)
mustbeincreasingrom left to right. Someseismogrameeedto be scannedengthwiseor inverted
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becausef physicaldamageo the paperduringstorage Consequentlyseveralimagemanipulation
functions(Fig. 6) areincludedto align the imagecorrectlyfor digitization. Aging or damageto

the paperseismogranguring storagecanresultin theinclusionof non-seismi¢imagenoise”that
needsto be filtered for efficient and accuratedigitization by the trace-trackingalgorithm. Most

of theseoperationsaretime consuming.Whendigitizing multiple seismograméaving the same
characteristicsit may be more corvenientto performtheseoperationsexternalto SeisDig using
prep_images.m (seeSection2.4.1).

birrar Ahout Y- A=0s |
Mirror About X-Axis

Rotate 150

Rotate +30 (slow)

Rotate -30 (50w

Filter Image Moize [slow)

Erode Image (slow)
Dilate lmage (slow)

Invett Image
Feload From Disk

Figure6: Operationgperformedunderthe lmage menu.

3.2.1 Image Manipulation Functions

Seismogrammagescan be rotatedabouteitherthe screenx-axis or y-axis using“Mirror About
X-axis” or “Mirror About Y-axis”, respectrely. Rotationof the imageaboutthe screenz-axis
canbedoneby clicking on the “Rotate 180" for 180° rotation,or “Rotate +90” or “Rotate -90”
buttonsfor clockwiseandcounterclockwise90° directions,respectrely (the + 90° rotationsare
muchslower operationdbecaus®f memoryreallocation).

3.2.2 Image Filtering

“Filter Image Noise” removesspuriousisolatedpixelsandoffsetminutemarksthatinterferewith

accurateautomatedligitizing, andis recommendedbr mostimages.“Erode” and“Dilate” func-
tions effectively contractor expand,respectrely, the imagetraceline thicknessput arenot rec-
ommendedor useexceptin specialcasesBecausemagefiltering operationcannotbe reversed,
thesefeaturesshouldbe usedwith caution. If theresultsof ary of thesefunctionsareunsatiséc-
tory, theimagecanbereloaded.

3.2.3 Invert Image

This function switchesthe background/forgroundfrom white-to-blackandvice versa. SeisDig
requiresablackbackgroundi.e. pixel valuessetequalto zero.
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3.2.4 Reloading

In theeventthatanimageis over-filteredor in someway corruptedduringdigitizing operationsthe
currentimagefile canbereloadedusingthe “Reload From Disk” option, which clearsall objects

andcontrolpoints.

3.3 Edit Menu

Digitizing modificationscanbe facilitatedby beingableto addor remove previously determined
overlays,aswell asundoincorrecttracemodifications.Suchfunctionsthathave provedusefulare

foundin the“Edit” menu(Fig. 7).

3.3.1 Undo

All operationsarestoredfor possiblerestoratiorto the prior state(exceptlmage menuoperations).
Successie operationscan be reversedby clicking on “Undo” or striking “<ctrl> u” usingthe
keyboard,or alsoby striking “u” if the mainimagepanelhasbeenactivatedwith a mouseclick

(i.e. is thecurrentMatlabobject).

Figure7: Operationgperformedunderthe Edit menu.

Undo u =< Cirl=—u

Show Control Points
show Trace Data
Show Opposite Image Edge

Show Reference Line
Cirder of Fit -

g irni g g g o Penien
LANRINRING ILTIDIRG D DWRSL Y LAWAIOA

Delete Line Caontral Paints

Find kdinute kdark Locations
Remowe kinute kdark Labels
Flot Pis/bAingTrace

Debug/Restare

3.3.2 Overlay Display Options

Operationdor the entireimageinclude erasingor redisplayingall control pointsand/orthe pro-
jecteddigitized tracesfrom the viewed imageby toggling the “ Show Control Points” and*“ Show

Trace Data” buttons.
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3.3.3 Shaw Oppositelmage Edge

Whendigitizing multiple traces settingcontrolpointsattraceendsfor preprocessingndadjusting
theEdgeLine fit, checkingtraceconcatenatioandtracenumberingor checkingthereferencdine

fit to theimage,” Show Opposite Image Edge” providesa corvenientfunctionto obsenethetraces
atoppositeendsof the seismogranimagesimultaneously

3.3.4 Show ReferenceLine

The seismogranimagetracescanbe slightly curved dueto incorrectpaperfeedin the scanning
operation. To establisha referenceline for determiningoutput digitized trace amplitudesthat
accountdor this slight curvature,a polynomialfit to the digitizedpointsof ordersl, 2, or 3 canbe
canbechoserusingthe“Order Fit” option. It is recommendethatfull tracesbe digitized using
a third orderpolynomial (the default). However, whendigitizing shortertracesegments,a linear
referencdine maybe moreappropriate: Show Reference Line” overlaysthe selectegpolynomial
fit onall tracedfor visualinspection.

3.3.5 DeleteLine Trace Data

If the trace-trackingalgorithmgetscompletely“lost”, it is sometimesecessaryo redigitizean
entiretrace. “Delete Line Trace Data” deletesall previously digitized datapointsonly for the
current(active)line.

3.3.6 DeleteLine Control Points

“Delete Line Control Points” deletesall controlpointsfrom the current(active) line.

3.3.7 Minute Marks

Thelocationsof minutetiming-mark(gaps)areestimatedisingamodificationof thetrace-tracking
algorithm,andarenumberedequentiallyandoverlaidon theimageusingthe“Find Minute Mark
Locations” function. Identifying minute marksis usedto determinethe Time ScaleFactor i.e.
the numberof pixels/min (seeSection5.1), neededo determineoutputtracesamplinglocations.
The DPI needgo be enteredor estimated}o determinehe minutemarklocations.The overlaid
minutemarknumbersanberemaovedfor theentireimagewith the* Remove Minute Mark Labels”
function. The Find Minute Mark Locations function may not work well for imageswith trace
overlaps.Whendigitizing full seismogranimagesjt canbeusefulto examinethevariationin the
pixels/min andminuted line estimategor all thetracesusingthe“Plot Pix/ Min/ Trace” function.

3.3.8 Dehug/Restore

Occasionally problemswith either Matlab or the trace-trackingalgorithm canoccur The “De-
bug/Restore” functionresetdhe GUI buttons,andrestoredine labelingandthe baselindocations.
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4 GUI Functions

Variousfunctionsfor moving aroundthe seismogranimageandcorrectingpoorly tracked traces
are activatedby mouseclicking on the appropriate‘button” at the left of the mainimagepanel
(Fig. 1). Thatfunctionremainsactive until eitherreclickingor anotheibuttonis actvated.Because
eachof thesefunctionsuseleft mouseclicks, only oneof thesefunctionscanbeactive atonetime.

4.1 Navigation

Moving within the imagecanbe doneby (1) usingthe scroll barson the bottomandright hand
sidesof the displayedimage, (2) by clicking on the desiredlocationin the locator panelat the
lower right, (3) by usingthe® Shift Image” button,or (4) centeringtheimageat the currentcursor
location by right clicking. The displayedportion of the imagein all casess identifiedby a red
boxin thelocatorpanelat thelower right, which displaysthe full imageandidentifiesthe current
active tracewith a horizontalmagentdine.

Shift Image|
| Zoom
-l 120 " +|
Image Ratio
1 |1
b4 i

Auto Scroll |

Delay IT

Figure8: Imagenavigationcontrols.The Zoom buttonis activated,i.e. beige.

4.1.1 Shift Image

Activationof the Shift Image buttonallows “grabbing” anddraggingthe displayedmageby hold-
ing down theleft mousebuttonandmoving the cursor

4.1.2 Image Magnification

Activatingthe®Zoom” buttonallowsimagemagnificationleft button,zoomin) or reduction(right
button,zoomout), with thezoomedmagecenteredatthe cursorlocation. The sizeandlocationof
theredlocationboxin thelocatorpanelis adjustedaccordingly Zoomingcanalsobeaccomplished
by clicking onthe“+” or*“-" buttonsadjacento thezoommagnificationdialogbox, with zooming
directedtowardsthe upperleft cornerof theimage.Clicking the middle mousebutton centershe
imageat the cursor The degreeof zoomingfor both mouseclicks in the mainimagepaneland
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usingthe + or - buttonsis a pre-determineghercentagef the size of the initial red locatorbox,
i.e. thesizeof theinitial imagedisplayedn the mainimagepanel. Thedegreeof zoomingdesired
canalsobe manuallyenteredn the Zoom dialog box, alsorelative to theinitial mainimage(red
locatorbox) size.

4.1.3 Image Ratio

Increasingheapparentelative amplitudeof thedependentariable(i.e. theverticalor y-direction
with an x:y Image Ratio of 1:50) is usefulfor identifying irregularitiesresultingfrom improper
scanningj.e. excessve tracecurvature(the traceimagesshouldbe nearlylinear). Conversely to

checkalignmentof thetraceends ahorizontal:\erticallmage Ratio of 100: 1facilitatestheaccurate
selectionof EdgeLine locationandslope.

4.1.4 Auto Scroll

After pre-processligitizationof afull seismogramgursoryinspectionof of theprojectedigitized
datato identify incorrectly tracedsegmentscan be performedusing“Auto Scroll ”, which steps
throughthe entireseismogramn incrementghe sizeof theredbox in thelocatorpanel,with the
viewing time in seconddetweensuccessie portionsenteredn the “Delay” dialog box. Either
mouseclicking on Auto Scroll or anywherein the SeisDig window stopsscrolling.

4.2 Digitizing Control/Trace Editing Functions

Digitizing traceimagesrequireschoosingcontrol pointsto constrainthe digitizing algorithm,and
to correctpoorly tracked trace seggments. Only one “trace editing” button can be activatedat a
time, with the activatedbutton becominggreen(Fig. 9). Traceediting functionsapplyonly to the
line numberdisplayedn theLine # dialogbox, theactive trace,unlessthe“Current” checkboxs
toggledto “All Lines”. TheCurrent / All Lines checkboxappliesto all traceeditingfunctions.

4.2.1 Control Points

Controlpointsareneededatthebeginningandendof eachtraceto identify thetime-axis(indepen-
dentvariable)baselineandthe traceextent, andwithin traceswhenthe trace-trackingalgorithm
hasdifficulty correctlyfollowing atrace.Controlpointsneednotbesetattheexactendof thetrace
(thetrace-trackingalgorithmwill goto the endregardless) Control pointscanbe addedat multi-
ple traceendsby holdingdown theleft mousebuttonanddraggingthe cursorfrom black-to-black
(non-image)locations,with a control point insertedat eachcrossingof a traceimage (white re-
gion). Controlpointscanbeaddedonly to thecurrentactive line indicatedin the Line # dialogbox
(unlessthe Line # checkbox is activatedfor addingcontrol pointsat multiple traceendsfor pre-
processing).Control pointsassociatedvith the numberin the Line # dialog box (active) arered,
while inactive areblue. Activatingthe“Insrt Ctrl Pt” buttonallows addingasmary controlpoints
asneededt selecteccursorlocationswith left mouseclicks. Control pointsgenerallyshouldbe
vertically centeredn theimagetrace(the default setting). Centeringcanbe turnedoff for special
casedy togglingthe“ Center ” checkbox (changeso “Exact”), andis particularlyusefulturned
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|Insrt Ctrl Pt
M Center
Del CtH Pt
select Pts
Erase Trace
M Cwrent

Figure9: Traceeditingcontrols.Thetraceeditingbuttoninsrt Ctrl Ptsis activated,i.e. greenwith
the Center checkboxactivatedcausingsubsequentontrolpointsinsertedio bevertically centered
in the Current traceindicatedin theLine # dialogbox.

off whenadjustingthetrackingattraceintersections.

Incorrectlyaddedcontrol pointscanbe deletedat any time by activatingthe“Del Ctrl Pt” button
andthenclicking on the erroneousontrol pointswith the mouse. Individual control points can
be deletedfrom ary traceat ary time with mouseclicks by toggling the Current checkbox(the
default) to All Lines. Successiely addedcontrol pointscanbe sequentiallydeletedby striking the
“u” key for “Undo” afteractvatingthemainimagepanelis madetheactive objectby mouseclick.
All controlpointsin atracemaybe deletedwith Delete Line Control Points in the Edit menu.

4.2.2 SelectPoints

Groupsof controlpointscanbeselectedor deletionor for incrementindine numbersy activating
the“ Select Points” button andthenholding down the left mousebutton anddraggingthe cursor
to encompassontrol pointson the Current line or on multiple lines whenthe All Lines button
is active. To deleteselectedyroupsof control points, selectthe control pointsandthenstrike the
keyboard‘Delete” key. Toincremenbr decrementselectandthenclick onthe++ or —— buttons,
respectrely.

4.2.3 EraseTrace

High amplitudesignalsresultin traceoverlapsthatgenerallyrequireinteractve modificationof the
projecteddigitizedtrace. Incorrectlytracked tracedatacanbe removed usingthe “Erase Trace”
function, holding down the left mousebuttonanddraggingthe cursorto delineateprojectedtrace
datato be erased.The Current / All Lines checkbox appliesto Erase Trace (asfor othertrace
editing functions)so that incorrectly tracked signalscan be erasedwithout affecting previously
correctlydigitizedadjacentraces.An entiredigitizedtracemaybedeletedwith Delete Line Trace
Data in the Edit menu.
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5 Time and Amplitude ScaleFactors

Scalefactorsfor boththeindependenvariable(Time for seismogramsandthedependentariable
(Amplitude) (Figuresl and 10) needto be eitherenteredor computedprior to exportingdigitized
data.

SCALE FACTORS
Time {min) Amp {in.)
Length: 30 207 35,583
pizfunit: 452 400

Figure10: Time (independentand Amp (amplitude, dependentyariableScaleFactors,shaving
valuestypical for earlierGalitzin seismogramgéseeFig. 1).

5.1 Time (IndependentVariable) ScaleFactor

Thedigitizing Time ScaleFactor(TSF)is neededo determinethe sampling“locations” alonga
projectedtraceto obtainthe digitized output. An accuratesstimateof the TSF (pixels/unit(min))
of theimageis alsoneededo ensureconserationof elapsedime betweerStartandEnd Timesof
theseismogramTheseismograpldrumspinratevariesovertime (evenhourly) for olderGalitzin
seismogramggiving variabletracelengths(i.e. numberof minutes/trace).Thus,the TSF should
be estimatedor eachseismogramalthoughthe default medianvalue of 470 pixels/ min canbe
used. The TSFis determinedautomaticallywhendigitizing full seismogramsthat have minute
markgaps)asthemeanof thepixels/ min estimategexcludingoutliers)for all linesto bedigitized.
Thevariationin the (pixels/ min)/tracecanbe examinedusingthe Plot Pix/Min/ Trace function
in the Edit menu,andthenloadingthe automatically-generateassociatedgaps-"file.

Alternatively, whendigitizing short sgmentsof seismogramsthe TSF canbe estimatedoy en-

teringthe Length (for seismogramshe numberof minutes)betweernwo selectedointswithin a

tracedelineatedvith the EdgeLines (movedto clearly definedminutemarks)in the ScaleFactors
“Time (min)” dialogbox. The numberof minutescanbedeterminedisingthe*Find Minute Mark

Locations” functionin the Edit menu,with the minutemarkgapsnumberedsequentiallybetween
control pointsand shovn on the traceto checkthat the minute markswere correctly identified.
ThesenumbersanberemovedusingRemove Minute Mark Labels in the Edit menu.

Whentick (minute)markgapsareabsen(asin Fig. 1), theimagequalityis poor, or multiple trace
overlapsoccur theminutemarksmay notbeidentifiedcorrectlywith eitherthe Find Minute Mark
Locations function or by visualinspection.In suchcasesthe TSF (pixels/ min) mustbe entered
manually Thisis doneby activatingthe Time, pix/ unit dialogbox by mouseclick andenteringthe
pixels/ min value(or usingthe default estimateof 470),andstriking the Enterkey. Thecomputed
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tracelength(in minutes)basedon the enteredl SF (andthe EdgeLine positions)will thenappear
in the Length dialog box.

The TSF canalsobe determinedor the full seismogranusingthethe StartandEnd Times(an-
notatedon the physicalseismogramgnteredin the Export (Preview) window. If StartandEnd

Times are enteredand acceptedthe computedTSF will not be used. Becausehe tracelength
in older Galitzin seismogramsanvary from slightly lessthan30min to about31min (the Plot

Pix/Min/ Trace function in the Edit menualso plots the numberof minutesper line), the TSF
estimateshouldbe obtainedrom the displayedseismogranimageor from atracechronologically
close.

5.2 Trace Amplitude (DependentVariable) ScaleFactor

The Amplitude ScaleFactor(ASF, dependentariable)for thedigitizedtime seriescorrespondso

theimageDPI (dotsperinch). The DPI is usedto corvertthe seismicdigitizedtraceoutputampli-

tudesfrom pixelsto millimeters. The DPI is generallyknown andshouldbe enteredn the Scale
Factors” Amp” pix/unit dialog box (the defaultis 400dpi). The enteredDPI is usedto compute
the physicaltracelengthbetweenthe EdgeLines, shovn in the Length ScaleFactorsAmp dialog
box (Fig. 10). Thisvalueshouldcorrespondo themeasureghysicaltracelength. TheEdgeLines
canbeadjusteduntil the computedraceLength matcheshe measuredength.

If the DPI is unknown, the original paperseismogranphysicallength,i.e. the measuredrace
length,canalsobe usedto determinethe numberof pixels/inchor DPI amplitudescalingof the
image. The unitsof the paperseismogranphysicaltracelengththatgeneratedhe scannedmage
arein “inches” to conformto the DPI corvention. Enterthe paperseismograntracelengthin the
Length ScaleFactorsAmp dialogbox (Fig. 10). The numberof pixelsbetweerthe EdgeLinesset
atthetraceendsthengivesthe ASF.
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6 Digitizing Quality Control

The projectedoutputtraceof the digitizing algorithm shouldbe inspectedo ensurethe quality
of the digitized data. Becausdhereare several factorsthat affect the traceimagequality, initial
projecteddigitized traceestimatesften requirecorrection. After Pre-Processing, entireimages
canbe scannedor digitizing errorsusing Auto Scroll. Prior to saving to disc during Export, the
concatenatedigitized tracesaredisplayedin a scrollablewindow that appearsafter clicking on
Export (Preview) in the File menu. After correction,the digitized datamustbe re-Exported, and
modifiedsectionsshouldbere-inspected.

6.1 Interactive Trace Modification/Editing

Incorrectimagetrace-trackings easilyidentifiedby comparingthe projecteddigitized tracewith
the underlyingimage,or by identifying inconsistenamplitudesn the Export (Preview) window.
Poortracetrackinggenerallyresultsin highamplitude*spikes”, which canbelocatedby searching
throughthe tracein the main Export panelby usingeitherthe scroll bar or by toggling the Line
checkboxto Nmax (the “next maximum”) andexaminingsuccessie maxima.Poorlytracked sec-
tionsshouldbe modifiedin the main SeisDig panelandthenre-Exported.

Changinghetrace-trackingcanbeaccomplishedby insertingcontrolpointsatlocationswherethe
projecteddigitized tracedeviatesfrom the underlyingimage. Clicking on Insrt Ctrl Pt activates
Insert mode.In mostcasesre-digitizing modifiedtracesectionsshouldbe doneusingthe Pt 2 Pt

function. This reducedigitizing time andavoids the possibility of adwerselyaffecting previously
digitizedtracesggmentsthatwereacceptable.

Control pointsshouldbe insertedto guidethe trackingalongthe correctpath. Groupsof control
pointscanbe insertedin poorly tracked segmentsalonga singletrace(while in Insert modewith
the Current checkboxactive) by holdingdown theleft mousebuttonanddraggingthe cursorhori-
zontallyfrom anon-imageregion to anothemon-imageegion (black-to-black)alongatrace with
controlpointssetat eachimagelocation(white) crossed.The Pt 2 Pt digitizing functioncanthen
be applied.On occasionsvhentheimagequality is poor but thetraceis potentiallyidentifiable, it
is usefulto loadtheraw, unfilteredseismogranimage,overlaythe projecteddigitized data(deter
minedfrom thefilteredimage),andusetheraw imagedataasthe guidefor settingcontrol points
to improve tracetracking. In casesof poorimagequality, sectionsof a digitized tracethat have
beenpoorly trackedcanbedeletedwith “Erase Trace” by holdingdown theleft mousebuttonand
selectingthe desiredarea. Several applicationsof the Pt 2 Pt digitizing function (with repeated
additionsof controlpoints)shouldbe usedprior to resortingto Spline Fitting.

6.1.1 Spline Fitting

In instance®f extendedpoorimagequality but with avisually identifiabletrace holdingdown the
left mousebuttonanddraggingthe cursorfrom anidentifiedportion of the traceimageto another
identifiedimagepoint (“white-to-white” while in Insert mode)identifiesa sectionfor “spline” fit-
ting. Otherpre-&isting controlpointswithin the splinedsectionbecomencorporatedn thespline
fit. Repeatedlicks onidentifiabletracesggmentswithin thesplinesectionconstrainghe splinefit.
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Figurell: ThemainSeisDig panelshonving anexampleof aportionof atraceimageatthe begin-
ing of Line 42 (upto aboutthe0.95inchtracelocation)thatwasspline-fitted.Redcirclesconnected
by thin redlinesidentify locationsof splinecontrolpoints. Comparewith theunmodifiedprojected
tracedeterminedy thedigitizing algorithm(Fig. 1, begining of Line 42).

Notethatindividual control pointscannotbe deletedwithin splinesections.If the splinedsection
is unsatishctory useErase Trace to deletethe projectedtracein the splinedsection,followed by

Sect Pts andstriking the keyboardDeletekey (seeSectiord.6) to deleteall controlpointswithin

a splinedsection. Figure 11 shows a splinedsectionat the begining of Line 42, up to aboutthe
0.95inch tracelocation. The blank spacebetweenthe (green)EdgelLine andthe begining of the
traceresultsfrom fadingof the seismograntracesat this edge with the EdgeLine setto consere
the Total Time in the seismogram.

6.2 Trace Concatenation

Digitizing consecutre tracesin a seismogrammagerequiresconcatenatinghe traceat oneend
of the imageto the next traceat the oppositeend. Storageproblemsover time have resultedin

degradedimagequality at the edgesof someseismogramsgseeFiguresl and11). Minute marks
andfadedtraceendscanresultin gapsat traceconnectionghat needto be accountedor. When
digitizing full seismogramsthe usersetsthe “Edge Line” locationfor the endof the imagethat
is bestdefined. The other EdgeLine canbe iteratively adjustedto minimize the time difference
betweerthedigitizedandenteredrotal (elapsed)imes,determinedrom the StartandEnd Times
enteredoy theuserin the Export (Preview) window.
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The concatenatedigitized tracescanbe examinedby clicking on the Export (Preview) buttonin
the File menu,with the connectionlocationsidentified for inspection(seeFig 5). Any needed
modificationat traceconnectiongor EdgeLine adjustmentranthenbe performedn the SeisDig
window (nearthe connectionlocationsof the indicatedline numberin the Export window) and
thenre-Exporting. Datagapslessthan 50 pixels (about5s at 400dpi) that commonlyoccurbe-
tweenconcatenatettacegandat minutemarks)areautomaticallysplinedacrossyith largergaps
designateégsmissingdata.

7 Digitizing Procedure

7.1 Seismograms

e Importtheimage,rotateandmirror theimageasneededsothat Time (theindependentariable)
increaseg$rom left-to-right andtop-to-bottom.Filter theimagenoise.Becausdiltering theimage
is CPUandmemoryintensvein Matlab(i.e. slow), the Save Image optionshouldbe usedsothat
imagefiltering androtation do not have to be repeatedbe careful not to overwrite the original
imageunlessdesired).If morethanoneimagehaving the samecharacteristicss beingdigitized,
prep_images.m canbe usedexternalto SeisDig.

e Setcontrol pointsat bothendpointsof all lines (or theline segment)to be digitized. It is more
efficientto setall the controlpointson onesideof the seismogranimage,andthenthe otherside.
Whensettingtrace-enctontrolpointsfor successielines,“activating” theLine# checkboxmakes
it is unnecessarto changeheline numberin theLine # dialogbox.

The following two operationsare necessarynly whendigitizing multiple traces,althoughthis
procedurenaybeusefulin estimatinghearrival time of anearthquak signalif arrival time deter
minationby inspectionprovesproblematicor backgoundoiseestimatesareneeded.

e Goto thefile menuandclick on Save Data, resultingin the control points“prep-*.data” file-
namebeing addedto the Preprocess File List. Click on Digitize Selected (pre-processingakes
30-45min/seismogramdependingpn machinearchitecture).

e After digitizing is completed load the control points and projecteddigitized trace datausing
Load Data in theFile menu.Loadingthe“tr-*.data” file will automaticallyjoadtheimageandthe
projectediracesin which the controlpointswereselected.

Thefollowing arenecessaryor all digitized data.

e Comparedheprojectedligitizedtraceswith theunderlyingimageandinteractvely correctpoorly

trackedtracesegmentgseeSectionss and4.2).

e Enterthe DPI. If the DPI is unknowvn, enterthe physicallengthof the horizontaldimensionof

thescannegaperseismogranin “inches” in the Amp, Length dialogbox.

e A leastsquaredit is usedto determinethe referencdine for eachtrace. The linearity of each
traceandthe referencdine third orderpolynomialfit canbe moreclearly obsered by changing
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the horizontal:\erticalimagescalingratio to 1:50. Changethe orderof fit if desiredin the Edit
Menu.

e Setthe EdgeLines at both endsof the image. Settingthe EdgeLinesis necessarpnly when
concatenatingnultiple traces determiningthe total elapsedime in the seismogramor whende-
terminingthe ScaleFactors(eitherthe TSF or to checkthe DPI). If timing mark gapsareabsent,
usethe TSFdeterminedrom the enteredStartandEnd Timesin the Export (Preview) window or
usethe default pixels/min value (470, or an estimatefrom the closestchronologicallyavailable
seismogramin the Time (min), pixels/unit dialogbox.

e Export andPreview to ensuredigitization (and concatenationdf the traceswasdoneproperly
Save Data in casefurtheradjustmentgrenecessarat a latertime. Adjust connectiorsegmentsf
neededy modifying thedigitized dataat thetraceendsandrecheck.

¢ Entertherequiredheadelinformationin the Export window, StartTime (andEnd Time for full
seismogramspgndthe samplingrate. Adjust EdgeLinesif neededRe-Export.

e Save thedigitizeddatain eitheror both SAC2000Matlabfile andstandardSAC formats.

7.2 Generic Series: Time or Otherwise

Digitized datamay be obtainedfor otherimageswhere the independentariableis increasing
monotonically Determinatiorof the independenanddependenvariablescalefactorsis madeby

enteringtherangeof theindependentariableandthe physicaldimensiorof thescannedhardcopy

in the Length dialog boxes, respectrely. The remainderof the digitizing procedureollows that
for seismograms.
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8 Keyboard Shortcuts

Sometimest canbemoreefficientusingthe keyboardto employ traceeditinganddigitizing func-
tionsinsteadof themouse.

Notes:

1. All lower anduppercaseletterswill have the samefunctionunlesssomeotherfunctionalityis
explicitly stated.

2. Keypresdunctionsonly work whenthefigureis theactive object. Thekeyboardwill beignored
if any text fields, buttons,or slidersareselectedThe exceptionis whenusing<ctrl> with akey.

[0-999] <enter> : Jumpto line number(Ex: 16<enter> goesto line 16)
x/ X : decreasé increasex-axisratio

y/Y : decreaséincreasey-axisratio

<space- : Digitize Pt2Pt

> : Incrementine number

< : Decrementine number

M : Resetine numberto top

+ : Zoomin

: Zoomout

: TogglelnsertCtrl Pt

: ToggleDeleteCtrl Pt

: ToggleSelectPts

: ToggleEraseTrace

: ToggleShift Image

: ToggleZoomButton

u, <ctrl> u: Undo

“:” . Toggle“Center” checkbox

? . Toggle“Current / All Lines” checkbox

<Del> : Deleteselectedontrolpoints

Keyboard“arrows”. 1, |, <, — : Scrollimagein mainpanel
‘ : Enablekeyboardpromptdelugging

~ . Enableimagecropping,delineatinghe areawith themouse

NITmr QO
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9 SaisDig SAC2000Structures

The SeisDig Matlab headeistructsdo notincludeall thosefoundin the LawrenceLivermoreNa-
tional Laboratory(LLNL) SAC2000release Whenin SAC2000,moreheadeinformationcanbe
obtainedwith “SAC> helpmat”. A brief comparisorof structsin SAC2000andSeisDig is given
below.

Identical to the SACdata structuresin SAC2000:

structtimes:
deltab eo af
t0t1t2t3t4t5t6 171819
ko ka ktO kt1 kt2 kt3 kt4 kt5 kt6 kt7 kt8 kt9 kf

structstation:
stlastlo stelstdp
cmpazcmpinc
kstnmkcmpnmknetwk

structevent:
evla evlo evel evdp
nzjdaynzyeamzhournzminnzsemzmsec
kevnm magimagtypimagsrc

trcLen (integertypein SAC2000)

Structs Not included in SAC files exported from SeisDig:

user descrip.evsta,linl, response

New struct in SeisDig export files:

structSeisDig:
num.pixels: total numberof pixelstraced
px_per.min
samplesper.sec
px_per.delta
original_px_permin : valuelistedin SCALE FACTORSboxin main SeisDig window
samplingmethod:always“nan spline”
min_perline : valuelistedin SCALE FACTORSboxin the SeisDig window (minutes)
physicallength: valuelistedin SCALE FACTORSboxin the SeisDig window (inches)
dpi : dotsperinch
dpmm: dotspermm
imagefilename: filenameof imagefile digitized





